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Introduction

This manual describes how to use the WebView Livescope Ver. 3.6 Viewer Software.
There are two types of viewers, Viewer for Java and the Viewer for PC, and the video
sender can use one or the other as required. Both types provide the same basic
functions for viewing videos, but differ in terms of other features and functions. The
preparations for using the two viewer types and the required operating environment also
differ depending on the computer hardware and software used to run the viewer.

Read this manual carefully before you use the viewer to ensure that you make the best
possible use of this product.

Store this manual in a safe place after you finish reading it.

The latest information on the viewer is available at the following URL.
http://www.canon.com/webview

Important

(D Copyright © 2005 by Canon, Inc. All rights reserved. The unauthorized transfer of all or
any part of the contents of this manual is forbidden.

® The contents of this manual are subject to change without notice.

@ Every effort has been made to ensure that content of this manual is free from errors.
If you encounter any errors, omissions or apparent inaccuracies, contact the
manufacturer.

@ Notwithstanding the above, Canon accepts no liability for any results arising from the

operation of this product.

4 N

On Copyrights

Videos or images taken or recorded with the viewer may not be utilized or published, without consent of copyright
holders, if any, except in such a way as permitted for personal use under relevant copyright law.

J
. . )
Usage Notice of Audio
1. Audio stream may be interrupted according to the performance of your PC and network environment.
2.1f you use a proxy server, the audio may be interrupted.
3.1f you use a PC on which anti-virus software is installed, the audio may be delayed or the audio stream may be
temporarily interrupted.
J
] )
Trademark Information
Canon and Canon logo are registered trademarks of Canon Inc.
Microsoft Windows and Microsoft Internet Explorer are registered trademarks of the Microsoft Corporation in the
United States and other countries.
Netscape is a trademark of Netscape Communications Corporation.
Java and all Java-based marks are trademarks or registered trademarks of Sun Microsystems, Inc. in the United
States and other countries.
All other company or product names used in this document are trademarks or registered trademarks of their
respective holders.
* In this document, “Microsoft Windows” is abbreviated as simply “Windows”.
S J
. 7
Conventions
Indicates important notes or restrictions that must be observed when using this product. Always
Note read these notes.
Indicates additional information or explanations for a procedure. You should read these items.
S J




WebView Livescope Overview

W WebView Livescope is the system that allows camera control and live video distribution from a
remote location.

W The system is configured for a camera server and viewer software. The camera server distributes
live video taken by the video camera to the Internet or an Intranet. The viewer software can display
the video and remotely control the camera.

B The WebView Livescope system can be used in a wide range of applications such as distributing
live video from a Web site and monitoring.

The following types of camera servers are available:
* Network Camera Server VB150

* Network Camera VB-C50i/VB-C50iR

» Network Camera VB-C50FSi

» Network Camera VB-C50Fi

The following types of Viewer Software are available:

* Viewer for Java (This manual: provided free of charge with camera server product)
» Viewer for PC (This manual: provided free of charge with camera server product)

* Network Video Recorder VK-64 (Sold separately)

» WebView Livescope MV Ver. 2.1/LE (Sold separately)

WebView Livescope is a video distribution system that enables users to
actively (by performing operations by oneself) view live (showing now) video
from Web pages by allowing users to change camera angle and zoom magnification.

Video Sender . .
(Camera server) Video Recipient
(Viewer software)

aici

VB-C50FSi/

VB-C50Fi

Offers an easy way Offers the advantage of
to provide live information contents. being able to actively select desirable
parts from live video according to
the user’s purposes.

B The names of the viewers have been changed as follows:

Old Name New Name
Helper Viewer Viewer for PC
Java Viewer Viewer for Java




Viewer Overview

There are two types of WebView Livescope Viewer Software: the Viewer for Java and the Viewer for
PC.

_Vﬁwer for Java

This is a viewer written using Java. This viewer allows the camera server’s videos to be
viewed on any computer with a Web browser that runs Java, regardless of the platform.
Because the Java applet is downloaded when the viewer starts up, the first video takes
some time to appear. The Viewer for Java provides two types of viewers: LiveApplet
containing video display and camera control functions, and Glimpse containing a video
display function.

LiveApplet

Video display functions ] oo
Camera control functions | o=

nnnnn

Glimpse

Video display functions

E @ To use the Viewer for Java, you need to install Java VM beforehand. See the
web site for more details.
WebView Product web site http://www.canon.com/webview
@ Panorama pictures must be registered in advance at the camera server.
*Panorama pictures are not available with the VB-C50FSi/VB-C50Fi.

Note



y_‘,bwer for PC

This is a viewer that runs as an application. This viewer provides video display and camera
control functions and appears in a separate window at startup. While the Viewer for PC has
to be pre-installed, it offers the advantage of displaying the first video quickly. At present,
only a Windows version of this viewer is available.

% WebView Livescope - 192.168.100.1:65310 ] 4|
File Wiew Preset Help
ele] W] D S =

Camers  [Shirickasla B e

I- Select camera presets -

Frame rate: 29,99 fps  Size: 320x240  Protocal; Wy-TCP

Panorama picture

E @ The Viewer for PC is provided on the CD-ROMs supplied with the Network
Camera Server VB150, the Network Camera VB-C50i/VB-C50iR, VB-C50FSi

and VB-C50Fi packages. The viewer can also be downloaded free of charge
from the following web site.
URL : http://www.canon.com/webview

® The Viewer for PC needs to be pre-installed on your computer. (— p.26)

@ Panorama pictures must be registered in advance at the camera server.
*Panorama pictures are not available with the VB-C50FSi/VB-C50Fi.

® When playing back audio, please read carefully “Usage Notice of Audio”
(— P.4).
* Audio input/output is not available with the VB-C50Fi.

Note

V1

O @ Because the Viewer for Java is downloaded from the camera server every

y time you access and displays video on the viewer screen, it starts up
slower than the Viewer for PC that is pre-installed on a PC.

@ Use the Viewer for Java when you access the camera server and view video
for the first time. However, we recommend you to install and use the Viewer
for PC if you view video frequently.

Tip




Operating Environment

For the latest information, please refer to our WebView Product web page:
http://www.canon.com/webview

\Lipwer for Java Ver. 3.6

Operating System/
Web Browser

Windows 2000 (SP4)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Windows XP (SP1a)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Windows XP (SP2)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Windows Server 2003 Standard Edition/Microsoft Internet Explorer 6.0, Netscape 7.1, 7.2
Windows Server 2003 Standard Edition (SP1)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Java VM

MSVM Release 5.0.0.3810 (Java VM provided by Microsoft)
Java Plug-in 1.4.2 (Java VM provided by Sun Microsystems)

*Java VM must be installed beforehand. If the Java VM provided by Microsoft has not been installed, please access
Sun Microsystems Website to download the Java VM provided by Sun Microsystems.

* Operation is unstable when used with an OS or Web browser other than those noted above.

\Lipwer for PC Ver. 3.6

Operating System/
Web Browser

Windows 2000 (SP4)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Windows XP (SP1a)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Windows XP (SP2)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Windows Server 2003 Standard Edition/Microsoft Internet Explorer 6.0, Netscape 7.1, 7.2
Windows Server 2003 Standard Edition (SP1)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

* Must be installed in advance from the CD-ROM supplied with the camera server. (— p.26)




Chapter 1

Viewer for Java

This chapter describes the preparations required for using the Viewer for Java
and explains how to use the viewer.




Preparations for Using the Viewer for Java

The Viewer for Java is automatically downloaded from the camera server. There is no need to install
it in advance. However, depending on the type of Web browser you are using and your software
settings, you must change your Web browser settings.

lij;ing Internet Explorer

Internet Explorer has a setting that specifies whether the use of Java is permitted.
From the “Tools” menu, select “Internet Options” and click the “Advanced” tab. Then set “JIT
compiler for virtual machine enabled” as the “Microsoft VM” setting.

=ix|  * For Internet Explorer 6.0
eneral | Security | Content | Connections | Programs  Advanced |
Settings:
HTTP 1.1 settings -

Use HTTP 1.1
[ Use HTTP 1.1 through proxy connections
Micrasoft WM
[ Java console snabled (requires restart)
[ 3avalogging enabled
JIT compiler For virtual machine enabled (requires restart)
18, Multimedia
[ Awsarys shows Inkernet Explorer (5.0 ar laker) Radio tolar
Play animations
Play sounds
Flay videos
O show image download placsholders
show pictures
Smart image dithering
& Printing
4

o
Restore Defadlts

of || cancel || anl

In Windows XP, Java VM may not be installed. If this is the case, please install it. See the

web site for more details.
WebView Product web site

http://www.canon.com/webview

Detailed settings below similar to the ones are displayed after settings.

General | Security | Privacy | Content| Connections || Programs | Advanced
Settings
&1 HTTP 1.1 settings A
UseHTTP 1.1
[ Use HTTP 1.1 thiough prosy connections
& Java(Sun)
Use Java 2 w1.4.2_03 for <applets (requires restart)
#8, Mulimedia
[] Don't display online media contant in the media bar
Enable Automatic Image Resizing
Enable Image Toolbar [equirss restart]
Play snimations in web pages
Play sounds in web pages
Play videos in web pages
[ Show imags download placsholdsrs
Shiw pictures
Smart image dithering
@ Piinting v
< >

* For Internet Explorer 6.0




jing Netscape

Netscape also has a setting that specifies whether the use of Java is permitted.

Select “Preferences” from the “Edit” menu, click “Advanced” and then click in the “Enable
Java” checkbox.

Preferences

Category.

e [Adeneed T
< Navigator 7 !
History
) Enble Java
Helper Applicat.. [ Enable native object scripting.
o P 3
|
Tabbed Browsing
Oonnloads |-}
b, Conposer | - cuickianch
D Mail & ewsoroups
> (m]
KKQ use, abowing tto start up Faster.
< advanced
Scripts & Plging
Keyboard Navi...
Cache.
Provies
HITP Networking
Software Insa..

Note

* For Netscape 7.1

The settings for the Web browser vary depending on the version used. Refer
to the settings given here and check your browser version.




When You are Connected to a LAN

If the camera server is used via an Intranet and you specify the Web browser proxy
setting manually, videos are distributed via the proxy. This can result in a slower
frame rate and proxy server overload.

Use the procedure shown below to set up a “No proxy” connection. Note that if
you are accessing a camera server that is located outside a firewall on the internet,
registration is not required for the camera server.

Setup Examples

Using Internet Explorer
Specify either “Automatically detect settings”, “Use automatic configuration script” or “Use
a proxy server for your LAN” below.

® Automatically detect settings

(D From the “Tools” menu, select “Internet Options” and click the “Connections” tab.

® Click “LAN settings” to open the Local Area Network (LAN) Settings dialog box.

® Tick “Automatically detect settings” in “Automatic configuration”.

@ Click “OK” to close the Local Area Network (LAN) Settings dialog box and the Internet
Options dialog box. Proxy data is automatically detected when you specify this setting.

Local Area Network (LAN) Settings 2% * FOr Internet Explorer 60

- Automatic canfig
‘Automatic confiauration may overrids manual settings, To ensure the
use of m ings, disable: rfiguration.

- Proxy server

= Use 2 proy server for your LAN (These settings wil not apply to
disk-up or PN connections).

fddress Port: Advanced,,,

T Bypes proy server for loal eddresses

@ Use automatic configuration script

(D From the “Tools” menu, select “Internet Options” and click the “Connections” tab.

@ Click “LAN settings” to open the Local Area Network (LAN) Settings dialog box.

® Tick “Use automatic configuration script” in “Automatic configuration” and enter the URL
(e.g. http://192.168.100.10/proxy.pac) of the Settings file.

@ Click “OK” to close the Local Area Network (LAN) Settings dialog box and the Internet
Options dialog box.

Local Area Network (LAN) Settings 2| x| * For Internet EXp|0I’eI’ 6.0

Autornatic
Automatic configuration may override manual settings. To ensure the
n,

use of manual settings, disable automatic configuratio
I Automatically detect settings
2 Lge actomati configuration scrpY

Address

Proxy server

I~ Use a proxy server




Preparations for Using the Viewer for Java

@ Use a proxy server for your LAN

@ From the “Tools” menu, select “Internet Options” and click the “Connections” tab.

® Click “LAN settings” to open the Local Area Network (LAN) Settings dialog box.

@ Tick “Use a proxy server for your LAN” in “Proxy server” and click “Advanced”.

@ In the “Exceptions” field, enter “Camera server IP address: HTTP conversion server
service port”. If there are multiple settings, use a semicolon (;) as the separator (e.g.
192.168.100.1:80;192.168.0.20:80).

® Click “OK” to close the Proxy Settings dialog box, Local Area Network (LAN) Settings
dialog box and the Internet Options dialog box.

2=l * For Internet Explorer 6.0
(@, Type Proxy address to use Port

(' HTTP: ,— : ,_
S e ¥
@ [ [
N —

I Use the same praxy server for &l protocols

~Except

Do pot use proxy server for addresses beginning with:
]

Use semicolons { ; ) to separate entries.

Using Netscape
Specify either “Manual proxy configuration” or “Automatic proxy configuration URL” below.

@ Automatic proxy configuration URL

(D From the “Edit” menu, select “Preferences”.

® Select “Proxies” in “Advanced” and select “Automatic proxy configuration URL”.

@ In the “Automatic proxy configuration URL” field, enter the URL (e.g. http://192.168.100.
10/proxy.pac) of the Settings file.

@ Click “OK” to close the Preferences dialog box.

= *For Netscape 7.1

< Navigator he Internet
History

(O Direct connection to the Internet
| @ Manusl proxy configuration |

Keyboard Navi...
Cache

Proxie:
HITP Networking
Software Insta...




Preparations for Using the Viewer for Java

@® Manual proxy configuration
@ From the “Edit” menu, select “Preferences”.

@ Select “Proxies” in “Advanced” and select “Manual proxy configuration”.

® In the “No Proxy for” field, enter “Camera server IP address:HTTP conversion server

service port”. If there are multiple settings, use a semicolon (;) as the separator (e.g.
192.168.100.1:80;192.168.0.20:80).

@ Click “OK” to close the Preferences dialog box.

x
o [oroies ]
D Appearance (o]

< Navigator
Hstory
Languages
Helper Applcat...
Smart Browsing
Internet Search
Tabbed Browsing
Dowrioads =

b Composer

D Mai & Newsaroups

D Instant Messenger

(3

D Privacy & Securty

< advanced

O Direct connection to the Incernet
O Manual proxy configuration

HITP Proxy:

SsLProxy:

ETP Procy:

Gopher Proxy:

Example: mozlla.org, net.nz

©

Keyboard Navi..
Cache

Proxies

HITP Networking
Software Insta...

]
[ ]

D) G )

* For Netscape 7.1



Starting Up the Viewer for Java

The Viewer for Java is started up from the Web browser that displayed the Web page for distributing
videos.

To create a Web page for distributing videos, refer to the user's manual of the camera server you are
using.

A Shinjuku Alta - Microsoft Internet Explorer 3 N [=]
| Ele Edt Wew Favorites Tools el

When the “Using Viewer for Java” button in the
Web Browser that displayed the Web page for
distributing videos is clicked, the Viewer for Java
starts up and connects to the camera server.

TRYIl
Still Picture Recording




Using the Viewer for Java

_‘jiveAppIet” Screen

There are two types of Viewer for Java (— p.6). The following is a description of
“LiveApplet”. “LiveApplet” is a viewer with a GUI that allows the user to change the camera
angle, zoom ratio and backlight adjustment settings.

The functions of the GUI displayed on the Web browser are briefly described below.
Viewer for Java

LiveApplet

| Ble Edt vew Favertes Took el

320,240

Camera:  [Shiniuku, Japan

(=] [2] [e] [*] [=

P!
StarfCantiol

5 @

Video Source Size Change Buttons

The right-hand button makes the displayed video source one level smoother, while
the left-hand button makes it one level coarser. Making the image coarser increases
the frame rate, while making it smoother improves the video quality.

*Depending on the camera server, the video source size change buttons are not displayed.

@ | -select camdra presets -

(-]

Camera Selection Box
When multiple cameras are connected to the camera server, this box can be used to
select the camera.

Tilt Scroll Bar
Used to change the camera tilt angle (up and down movement).
*Not displayed on the VB-C50FSi/VB-C50Fi.

Zoom Scroll Bar

Used to change the zoom ratio.

Moving the button up zooms in (telephoto) and moving it down zooms out (wide-
angle).

Panorama View Button

Displays the pop-up panorama window. Panorama pictures must be saved at the
camera server. Panorama pictures will not be displayed if not saved.

*Not displayed on the VB-C50FSi/VB-C50Fi.

[o]  [o] [l [




(-]

(=] [5]

Bl [

=]

Camera Control Status Window
Used to display camera control information (“Camera controllable”, “Camera not
controllable”, “Awaiting turn”, “Remaining camera control time”).

Start Control Button
Used to acquire camera control privileges.

Backlight Adjustment Button
Compensates for backlighting. Useful when the video appears dark due to
backlighting. Click the button again to cancel.

Preset Selection Box
Allows you to control the camera by selecting preset camera positions registered
beforehand on the camera server.

Pan Scroll Bar
Used to change the camera pan angle (left and right movement).

*Not displayed on the VB-C50FSi/VB-C50Fi.

Snapshot Button

Shows a snapshot of the currently displayed video frame in a separate window. The

snapshot image can then be printed or saved.

Panorama Window * Not available with the VB-C50FSi/VB-C50Fi.

You can control the camera by clicking on the panorama window or dragging the yellow
frame on the panorama window.

i Captured Date: 30 Oct 2000 14:54:11

|Warning: Applet Window

this frame.

The blue frame indicates the area currently being photographed by the camera.
When you are granted control privileges, this changes to a yellow frame. You can

control the camera pan and tilt by dragging this frame and control the camera
zoom by resizing this frame.

The size of the panorama window may differ from that shown above if field of

ﬁ view restrictions have been specified on the camera server.
ote

—— The black frame indicates the range of
movement for the camera center. The
camera center cannot be moved outside




_Sjarting Camera Control

Although multiple clients can simultaneously connect to the camera server, multiple clients
cannot simultaneously control the camera. Consequently, “control privileges” has been
introduced by which only the client who currently holds the control privileges can control the
camera. Backlight adjustment and presets can also only be used when you have control
privileges.

Procedure

Click the [Start Control] button to acquire control privileges.

=]
Comers:  [Shiui 1zpan 5

: Camera Control Status Window
|| st cmrsvse ; Shows the camera control status.

l Camera Control Status Displays

The display changes depending on the camera control status.

IIl | | * Camera is not El [ 30 [ 30* You have been
‘B controlled. — . granted control

it ' ar

Start Control Start Control i, J fria] Start Contral prIVIleges_ The
G- e glege) .

e number beside

the clock icon is your period of

Izl [Wam [ waT * You have exclusive control.
. (B clicked the
b - [Start Control] El [ * You can retain
Start Contral Start Contral
button and the = control
camera server is being contacted. . privileges even
. . . At Eart] Start Contral
This display does not appear if the though your
camera server responds period of exclusive control has
immediately. expired. This is because there are
no camera control requests from
El [ > io* Awaiting other clients.
= control privilege

reservation. El [ ¢ For some

Starfontel

The number = reason, you

beside the person icon shows the 3 have been
. . . .. tarb Eartral Start Contral .

estimated time until control privileges disconnected
are granted. However, you may be from the camera control server, you
granted control privileges before this could not connect to the camera
number reaches “0” because other control server at startup, or your
users may cancel camera control or connection was not permitted. The
withdraw from the queue. status display panel turns red.

* For the VB-C50FSi/VB-C50Fi.




Using the Viewer for Java

_(j)ntrolling the Camera

Once you have been granted camera control privileges, you have complete control over the
camera angle, the zoom ratio and the backlight adjustment setting.

Changing the Camera Angle * Not available with the VB-C50FSi/VB-C50Fi.

Procedure

Move the button on the Pan Scroll Bar or Tilt Scroll Bar.

. By clicking a point on the video,
you can move the center of the
camera to that point.

— The camera angle changes to match
, the position of the scroll bar buttons.
[ peeemenm: =TI Tilt Scroll Bar

This scroll bar changes the camera’s tilt (up or down).
Pan Scroll Bar

Bl Changing the Camera Angle on the Panorama Window * Not available with the VB-C50FSi/
VB-C50Fi,

Warning: Applet Window

This scroll bar changes the camera’s pan (left or right).

By clicking
When you click on the panorama window, the camera pans and tilts so that the place
you clicked moves to the center.

By dragging
When you drag inside the yellow frame on the panorama window to another position,
the camera pans and tilts to shoot the area in the frame.




Changing the Camera Zoom Ratio

Procedure

Move the Zoom Scroll Bar button up or down.
The camera zooms in or out to match the position of the zoom bar button.

— Zoom Scroll Bar

Move the button up to zoom in
(telephoto).

Move the button down to zoom out
(wide-angle).

H Changing the Zoom Ratio on the Panorama Window * Not available with the VB-C50FSi/
VB-C50Fi,

i Captured Date: 30 Oct 2000 14:54:11

Warning: Applet Window

By dragging
When you drag the edge of yellow frame on the panorama window to change the
frame size, the zoom ratio changes accordingly.

\@ If you click outside the frame and drag the mouse while holding the button

: down, a blue frame is drawn. When you release the mouse button, the blue
frame turns yellow and the camera pans, tilts and zooms to shoot the area in
the new frame.

Tip




Using the Viewer for Java

Selecting the Camera

Procedure

When multiple cameras are connected to the camera server, you can switch between
cameras. Click on the Camera Selection Box to view the list of cameras. When you select a
camera from the list of names, the display changes to show the video from that camera.

Camera Selection Box

Using Presets

Procedure

You can control the camera by selecting preset camera positions (presets) registered on the
camera server.

Click on the Preset Selection Box to view the list of preset positions. When you select a
preset position from the list, the display changes to show the video from that position.

Preset Selection Box

The presets and camera selection options displayed are those set on the
camera server. If no presets or additional cameras are registered on the
camera server, no selection options are shown.

Note




Adjusting Backlight

Procedure

Backlight adjustment is useful when the video is dark due to backlighting.

When you click the [Backlight Adjustment] button, video darkened by backlighting becomes
brighter.

Click the button again to cancel.

|7 w0en

Backlight Adjustment
Button

@ [ - select camera presets -




Using the Viewer for Java

Taking a Snapshot of the Video

Procedure

This function allows you to take a snapshot (still picture) of a particular live video.
When you take a snapshot, it appears in a new browser window.

| smen
cam

| |- sect camera presets

When you click on the camera
icon, the still picture at the time
you took the snapshot appears in
a new window.

E @ Because a new still picture is captured when you click the camera icon, the
still picture displayed may be fractionally later than the moment you clicked
the icon.

@ Under copyright law, video or still pictures photographed by the viewer
cannot be used for any purpose other than personal enjoyment without
prior permission from the copyright holder.

® For Windows XP SP2 and Windows Server 2003 SP1 users, you may not be
able to use the camera icon to take shap shots. If so, hold down the Ctrl key
on the keyboard and click the camera icon or follow the instructions on the
displayed Information Bar to disable the pop-up blocker.

Note

-B- Printing and Saving a Still Picture

y The Viewer for Java does not have functions for printing or saving the video

displayed.

However, you can use the Snapshot function to save and print video as a still

picture.

(D Take a snapshot of the video you want to print or save.

® Use the Save or Print function in your Web browser to save or print the still
picture.

Tip




Using the Viewer for Java

jlimpse” Screen

There are two types of Viewer for Java (— p.6). The following is a description of “Glimpse”.
The “Glimpse” viewer is a light-weight Viewer for Java. It has a short download time as it has
no camera control functions and only displays video images.

This viewer is useful for viewing videos from multiple sites, as shown below.

7 Glimpse - Microsolt Intemet Explarer [_[OIx]

Viewer for Java

| Fle Edt View Fovortes Toos Help ‘

3 Glimpse

fujiyoshida

The Glimpse viewer is used only for viewing video; it does not include camera control
functions.




Chapter 2

Viewer for PC

This chapter describes the preparations required for using the Viewer for PC
and explains how to use the viewer.




Preparations for Using the Viewer for PC

I_I]stalling the Viewer for PC

The Viewer for PC must be pre-installed on your PC.
For details on installing, please refer to the user’'s manual of the camera server you are
using.

@ Microsoft Internet Explorer 6.0 must be installed to run the Viewer for PC.
Check that it is already installed before installing the Viewer for PC (— p.8).

@ If Ver. 3.5 or earlier viewer is already installed, when you try to install the
new version, a dialog box appears asking you if you want to uninstall the
old version. If you want to install the new version, click Yes, and the new
version will be installed after the installer uninstalls the currently installed
Viewer.

@ It cannot be installed in a machine in which WebView Livescope MV Ver. 1.0
has been installed.

Note

@ Follow the steps below if you are downloading from the web site and
i installing.
(D Download the install file from the web site.
@ Double-click “wvh361.exe”.
® Follow the instructions on the screen and install. When the setup
completion screen appears, click [Quit].
A short-cut icon is created on the desktop.



_U}ing Browsers Other Than the Recommended Products

To launch and run the Viewer for PC from a Web browser, the recommended browsers are:

Operating System/ Windows 2000 (SP4)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Web Browser Windows XP (SP1a)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Windows XP (SP2)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

Windows Server 2003 Standard Edition/Microsoft Internet Explorer 6.0, Netscape 7.1, 7.2
Windows Server 2003 Standard Edition (SP1)/Microsoft Internet Explorer 6.0 (SP1), Netscape 7.1, 7.2

The use of any browser other than these may require some setup measures. If you
cannot launch the viewer after installation, launch the Web browser and register the
application. For information on registering application, refer to the documentation
provided with your browser.

MIME type x-webview-h
Extension wvh
Application MonView.exe

The application “VBToolsInstall.exe” is installed into the folder
specified for the installation.

C:\Program Files\Canon\WebView\Viewer\3.6
(default installation folder)




Starting Up the Viewer for PC

The Viewer for PC can be started up in two ways: From the Web browser that displayed the Web site
for distributing videos, or starting it up independently. Normally it is started up from the Web browser.
To create a Web page for distributing videos, refer to the User's Manual provided on the CD-ROM

enclosed with the camera server package.

Starting Up from the Web Browser

A shinjuku Alta
| e Ede i

Click the “Using Viewer for PC” or other buttons
on the Web browser that displayed the Web
site for distributing videos . The Viewer for PC

starts up and connects to the camera server.

(=l
Fils View Preset Help
L O |
Comerec  [Shinjuku Alla = almum
=
m Z’
2[E=
15
|- Select camera presets | Start ool
Frame rate: 29,99 fps Siee: 320%240  Protocol: Wy-TCP
Elapsed tive 09:42

Starting Up Independently

Miewer far PiC

g MO CONNECTION]
Ele t telp

ﬁ Double-click

=loix]

Bl

- WebView

Livescope

,
o] | st

Elapsed time 00:00:00

Double-click the icon created on the
Desktop. It can also be started up by
choosing it from the Start menu:
Start | Programs | WebView
Livescope | Viewer for PC.

No connection to the camera server
(— p.29) is made when the Viewer
for PC is started up independently.



Connecting to the Camera Server

When you use the Viewer for PC to connect to the camera server and monitor, if the Viewer for PC was
started up from the Web browser, it automatically connects to the camera server. But if the Viewer for PC
was started up independently, you need to specify the camera server or select a registered camera server.
You can also change the connection target to another camera server while you are still connected to one
camera server, or start up multiple Viewer for PCs and connect each one to a different camera server.

§|}ecifying a Connection Target and Connecting

Procedure

% webVicw Livescone  [NO CONNECTION] Choose Connect from the File menu.
’ﬁ Wiew Preset  Help
Connect...

Register Site.

Start Conitral

|z| EEEEEER 2 The “Camera server address settings” dialog box
reons [Smi 00 appears. Enter each item and click OK to make a
r~Video connection settings ————————————————————— .
oy weE O e connection to the camera server.
¥ideo: Eco
Camera Contral: IV
HTTP: lso—
r~audio connection settings
I” Receive audio data
HITP: lsu—
Option. ..
e

B Host Name
Specify the IP address of the camera server

B Video connection settings
[Auto] [WV-TCP] [WV-HTTP]
Select whether to connect to the camera server using auto selection, or to connect
using the WebView-TCP or WebView-HTTP protocol. When connecting with auto
selection, the viewer automatically selects the optimum protocol and connects to the
camera server. If you are connecting to the camera server from inside a firewall,
select WebView-HTTP (— pp.44, 45).
[Video] [Camera Control] [HTTP]
Specify the port numbers of the camera server. These are the values specified on the
camera server. They can normally be used with the default settings.

B Audio connection
[Receive audio data]
Select to receive audio when audio has been transmitted. (For cameras which have
an audio function.)

Click “Option” to open the “Camera server address settings options” dialog box. Here
you can register sites. Click “OK” to return to the “Camera server address settings”
dialog box.

Camera server address settings options il

[ickmames |

|




Connecting to the Camera Server

B Add to camera site list
When this is ticked, camera server information that was entered is registered in the
viewer, and you can view video by simply selecting it from the selection box. Once
ticked, in the “Nickname” field enter the name with which you want to register.

§}Iecting a Registered Camera Server and Connecting

Procedure

bt bz [20 COMPECTION : =I5 Select the connection target from the site selection
Bz Zlwie| I— box. The camera servers displayed here are sites that
Carner v St isesme | were registered by selecting “Add to camera site list”

U charicnnizu Kands River

® = | when a connection was made by specifying a
connection target, or registered using the “Register
Connected Site button (— p.39)”".

m = | See p.47 for details on registering or changing a
25 server.

a

I d Start Carfral

[Elapsed tine 00:00:00 7

Disconnecting

Procedure

e =lodl - Choose Disconnect from the File menu, or close the

Flle Wiew Presst Help

e B| [omibuse | Viewer window to exit.

Start Contral

Stop the Picture
Restart tie Picture:

Copy te Picture
Save...
Prict,

X

E If you connect to a site containing user access restrictions, you will be asked

to enter a user name and a password. Enter the correct user name and
password to complete the connection. (Refer to the User’s Manual of the
camera server.)

Note

S

Vew preset Heb.

A A C | |

P —
oy o P/
Tl T x

- WebView
Livescope

Enter your uzer name and password,

User Mame: I\
Pazzword, I

Cancel

o}
A
=

Elapseditime 00




Using the Viewer for PC

The Viewer for PC provides a GUI that allows you to change the camera angle, zoom ratio and
backlight adjustment settings.

i\jiewer for PC” Screen

The functions of the GUI displayed when the Viewer for PC starts up are briefly described below.

1112|345

68./00.1:6 D =10 =]
Eilg Wiew Frese] Hel
ﬁlgl EL‘J@ §|_I Shinjuku Aha -jle— |

FEEE HE

Frame rate; 29,99 fps |Size: 320240

car
- Select camera praeets - j Slart‘ aritrol
P}tu:u WY-TCP

Elapsed timg 0942 %

(=] [x] [=]  [o] [o] [e] []  [2]

Video Source Size Change Button

The right-hand button makes the displayed video source one level smoother, while
the left-hand button makes it one level coarser. Making the image coarser increases
the frame rate, while making it smoother improves the video quality.

Full Screen Mode Button

Displays the video at full-screen size. Press the [Esc] key to return to the original video size.
Pause/Resume Button

Pauses video during play, or starts play if currently stopped.

Register Connected Site Button

Lets you register a camera site during connection.

Audio Settings Button

Lets you set audio functions.

*Only displayed if the camera is connected to a camera server that supports the Audio function.
Site Selection Box

Lets you connect to a registered camera site by selecting it here.

Camera Selection Box

Can be used to select the camera when multiple cameras are connected to the camera server.
Tilt Scroll Bar

Used to change the camera tilt angle (up and down movement).
*Not available with the VB-C50FSi/VB-C50Fi




Zoom Scroll Bar

Used to change the zoom ratio.

Moving the button up zooms in (telephoto) and moving it down zooms out (wide-
angle).

Panorama View Button
Displays the pop-up panorama window. Panorama pictures must be saved at the

camera server. Panorama pictures will not be displayed if not saved.
*Not displayed on the VB-C50FSi/VB-C50Fi.

E [

Camera Control Status Window
Used to display camera control information (“Camera controllable”, “Camera not
controllable”, “Awaiting turn”, “Remaining camera control time”).

Start Control Button
Used to acquire camera control privileges.

Backlight Adjustment Button
Compensates for backlighting. Useful when the video appears dark due to
backlighting. Click the button again to cancel.

Preset Selection Box
Allows you to control the camera by selecting preset camera positions registered
beforehand on the camera server.

El B & [E

Pan Scroll Bar
Used to change the camera pan angle (left and right movement).
*Not available with the VB-C50FSi/VB-C50Fi.

E

Panorama Window * Not available with the VB-C50FSi/VB-C50Fi.

You can control the camera by clicking on the panorama window or dragging the yellow
frame on the panorama window.

ured Date: 30 Dct 2000 14:54:11

The black frame indicates the range of
movement for the camera center. The
camera center cannot be moved outside
this frame.

Warning: Applet Window

The blue frame indicates the area currently being photographed by the camera
when you do not hold camera control privileges.

When you are granted control privileges, this changes to a yellow frame. This
frame not only indicates the area being photographed by the camera, but you can
also control the camera pan and tilt by dragging the entire frame around and
control the camera zoom by dragging the edge of the frame to change its size.

The size of the panorama window may differ from that shown above if field of

view restrictions have been specified on the camera server.
Note




Using the Viewer for PC

_Sdarting Camera Control

Although multiple clients can simultaneously connect to the camera server, multiple clients
cannot simultaneously control the camera. Consequently, “control privileges” has been
introduced by which only the client who currently holds the control privileges can control the
camera. The use of backlight adjustment and presets is also limited to the client who
currently holds the control privileges.

Procedure
Click the [Start Control] button to acquire control privileges.

% WebView Livescope - 192.168.100.1:65310 =10 x|

File Wiew Preset Help

EE RN

Carnera: | Shinjuku Alta

|
]
I 4
=
7
|
#
—
b=l

© e¥——— Camera control status window
= Shows the camera control status.
I— Select camera presets - d Start Cortral

Frame rate: 29.99 fps  Size: 320x240  Protocal: Wh-TCP

Elapsed time 03:42 2~

B Camera Control Status Displays
The display changes depending on the camera control status.

IIl [ Camerais not controlled. El [ Youcan retain control
(t

privileges even though
=3 your period of exclusive

Start Contral StarEantral " ”
control has expired. This
[2] e Awingconvlorviese SRS E Ao

reservation. The number )

gtanm beside the person icon For some reason. vou
shows the estimated time El  — have been discon,nyecte d

until control privileges are granted. 1

s from the camera control

However, you may be granted server. vou could not
control privileges before this number connect to the ca,rrz/era control server
reaches “0” because other users .

at startup, or your connection was

may cancel camera control or . )
withdraw from the queue. not permitted. The status display
panel turns red.

|z| w 30 You have been granted
control privileges. The

number beside the clock
icon is your period of
exclusive control.

€5
Star ]




_C_J)ntrolling the Camera

Once you have been granted camera control privileges, you have complete control over the
camera angle, the zoom ratio and the backlight adjustment setting.

Changing the Camera Angle * Not available with the VB-C50FSi/VB-C50Fi.

Procedure

Move the button on the Pan Scroll Bar or Tilt Scroll Bar.

The camera angle changes to match the position of the scroll bar buttons.

Also, if you click a point on the image, the camera moves so that the point you clicked
becomes the center of the video.

% webYiew Livescope - 192.168.100.1:65310 =10
Elle Yiew Presst Help
EI@I ﬁlmgl il Shinjuku Alta 'I
Camera: |Sh|n|ukuA\ta j m
: i TS e ) e By clicking a point on the video,
— you can move the center of the
camera to that point.
— Tilt Scroll Bar
:I This scroll bar changes the camera’s
= tilt (up or down).
Aa|F==
: t WYL 0] 15
4 o i = Pan Scroll Bar
S eleot camera presels - =l g‘a" Loy This scroll bar changes the camera’s
Frame rate: 29.99 fps Size: 320%240  Protocal: Wy-TCP n (left or right).
Elapsed time 09:42 pa (e t 0 g t)

B Changing the Camera Angle on the Panorama Window * Not available with the VB-C50FSi/
VB-C50Fi,

1 Captured Date: 30 Oct 2000 14:54:11 _ (Ol

Warning: Applet Window

By clicking
When you click on the panorama window, the camera pans and tilts so that the place
you clicked moves to the center.

By dragging
When you drag inside the yellow frame on the panorama window to another position,
the camera pans and tilts to shoot the area in the frame.



Using the Viewer for PC

Changing the Camera Zoom Ratio

Procedure
Move the Zoom Scroll Bar button up or down.
The camera zooms in or out to match the position of the zoom bar button.

5 WebYiew Livescope - 192.168.100.1:65310 =10l x|
File View Presst Help

e W O =T Shiricku Alts -
Camers; IShwmuku Alta j m.

®—1— Zoom Scroll Bar
Move the button up to zoom in (telephoto).
W = Move the button down to zoom out (wide-

E1==] angle).

- Select camera presets - j Start Control

Frame rate: 29.93 fps  Size: 320x240  Protocol: WY-TCP

Elapsed time 09:42 2

H Changing the Zoom Ratio on the Panorama Window * Not available with the VB-C50FSi/
VB-C50Fi.

1 Captured Dake; 30 Oct 2000 14:54:11 =]

Warning: Applet Window

By dragging
When you drag the edge of yellow frame on the panorama window to change the frame
size, the zoom ratio changes accordingly.

SIS If you click outside the frame and drag the mouse while holding the button

: down, a blue frame is drawn. When you release the mouse button, the blue

e frame turns yellow and the camera pans, tilts and zooms to shoot the area in
the new frame.




Selecting the Camera

Procedure

When multiple cameras are connected to the camera server, you can switch between cameras.
Click on the Camera Selection Box to view the list of cameras. When you select a camera from
the list of names, the display changes to show the video from that camera.

% WebView Livescope - 192.168.100.1:65310 B ] 3

Eile M“iew Preset Help

= T EINE ] Shinjuku Alta |
i 3 Camera Selection Box

Camera: juku

Using Presets

Procedure

You can control the camera by selecting preset camera positions (presets) registered on the
camera server.

Click on the Preset Selection Box to view the list of preset positions. When you select a preset
position from the list, the display changes to show the video from that position.

Preset Selection Box

Elapsed time 09:42 7

E The presets and camera selection options displayed are those set on the camera
server. If no presets or additional cameras are registered on the camera server,
no selection options are shown.

Note



Using the Viewer for PC

Changing the Video Source Size

Procedure

If multiple video source sizes are specified on the camera server, these buttons can be used to
select the size used for display. Changing the video source size does not change the size of the
video displayed.

* The effects of the Video Source Size Change Button may not be reflected in all camera servers or settings.

Makes the video source one level coarser (faster frame rate).

Makes the video source one level smoother (better video quality).

T Wel View Livescope - 192.168.100.1:65310
Preset sl

Camere:  [Shinuku ks = Eﬂm;

Select camera presets = Start Contial

Frame rate: 29.99 fps Size: 320x240  Prokocal: Wy-TCP

Elapsed tins 0942/

Using Full-Screen Mode

Procedure

You can use this function to view the video displayed at full-screen size. If you click the [Full-
Screen Mode] button and then click [OK] in the confirmation dialog box that appears, the video
appears at full-screen size. To revert to the

“’E“" - 122160 1E0E =l0x original video size, press the [Esc] key. If you
mle| @A @] s 5 click the right mouse button while in full-screen

mode, a pop-up menu
Fulscreen

appears from which
you can choose to
return to the original
video size or pop up
the panorama window
on the current video.

Switch ta full screen mode.

Push ESLC key ta return to narmal made.




Adjusting Backlight

Procedure

Backlight adjustment is useful when the video is dark due to backlighting.

When you click the [Backlight Adjustment] button, video darkened by backlighting becomes
brighter.

Click the button again to cancel.

% WebYiew Livescope - 192.168.100.1:65310 =100 =]
Elle Wiew Preset Help

e e e R [T Shinjuku tlla -1
Camera. IShwmuku Alka j W

[ Backlight Adjustment Button

il
Start Cortio|

I- Select camera presets - ﬂ

Frame rate; 29,99 fps Size: 320x240  Protocol: W-TCP

Elapsed time 02:42 7

Pausing and Restarting Video Display

Procedure

Video can be paused or restarted. Click the Pause/Restart button. Video can also be paused on the
menu that is displayed when you right click the mouse on the viewer screen. To resume, right click

%, WebView Livescope - 192.168.100.1:65310 _izi the mouse and select “Resume Paused Picture”.

Eile Wiew Preset Help

ﬂl%l MEI il Shinjuku Alta i

Pase Pture Drlay : — “Pause Picture Display” to stop video

Resume Paused Picture:

Ful 5creen Mods display and “Resume Paused Picture” to
: restart the paused video display.




Using the Viewer for PC

Registering a camera site during connection

Procedure

By registering a camera site during connection, subsequent connections to that site become
easy. The camera site currently connected can be registered by clicking the [Register

% WebView: Livescope - 192.163.100.1:65310 _ioix| Connected Site] button (up to 100 camera
sites). Registered camera sites are
displayed in the Site Selection box and can
%: Webyiew Livescope - [ND CONNECTION] _izixi| be connected to by simply selecting them.
Registered camera sites can also be
changed or deleted (— p.48).

Ele Wiew Preset Help

ﬂl%l ﬁl il Shinjuku Alta i

Fle Yiew Presst Help

Bz =we| - ——

Shiniul a
Shonan ZaimokuzaBeach
Harajuku Station

(chanomizu Kanda River

E2N  Menu-based Operations

All the functions accessed via buttons can also be accessed from the menu
bar. Functions that can only be accessed from the menu bar are discussed on
the following pages.

% WebView Livescope - 192.168.100.1:65310 I ] 3

Fl= W¥igw Preset Help

E ﬂlél il Shinjuku Alta - |
L

Connect. .. Display Size 3 1 ALTA

Reqgister Site Received Image Size  » Camera Select »
Start Conitrol Full Scresn Mode

Stap the Picture Panorama YWindow

Reestart: bhie Picture w Toolbar Display

Gopy bhe Picbure W Statusbar Display

56.\"3- o Video Information
Brint... Connect Information
Disconnect Camera Information
Exit

Metwark, ..

Audia...

Setup Properties. ..

Camera Site List..,

* See p.47 for details on using the Camera Site List.




Playing back audio

Procedure *This function cannot be used if the camera is connected to a camera
server that does not support audio.

Click [Audio settings] and configure the audio data sent from the camera server (For cameras
which have an audio function).

f‘ WebVYiew Livescope - 192.168.100.1:65310 - |E| 5[
Elle V¥iew Presst Help

] ] W S =] Shinjuku Alta -
pudio x|

F

Valurne
@ Low J High
[~ Mute

Play back the audio data: If this setting is ticked, and audio has been transmitted, the audio is
played back.

Volume slide bar: Adjusts the volume.

Mute: If this setting is ticked, the volume is turned off.

When playing back audio, please read carefully “Usage Notice of Audio” (—

- P.4).
\@ Even if the audio is played back, it will stop if the Viewer is minimized.
Tip

Saving and Printing Still Pictures

You can save and print snapshots of live video you want to retain.

Saving Still Pictures to Files

Procedure

When the video you want to save appears, click the [Pause/Resume] button.
The video is displayed as a still picture.

Select “Save” from the “File” menu.
When it ends, the video is resumed when you click the [Pause/Resume] button.

E Under copyright law, video or still pictures photographed by the viewer
cannot be used for any purpose other than personal enjoyment without prior

Not
oe permission from the copyright holder.

-B- Saved File Formats
- Files are saved in BMP format.

=
° Saved still pictures can be viewed using a Web browser or image display software.




Using the Viewer for PC

Printing Still Pictures

Procedure

III When the video you want to print appears, click the [Pause/Resume] button.
The video is displayed as a still picture.

IZI Select “Print” from the “File” menu. =
Printer System Printer [Canon Bubble-Jet BJC-210)
Frint position
+ Center of page Cancel |
Specify the print settings. € Upperleft of page Setup.. |
To change the printer settings, click the Bl B e e

[Setup] button.
When you have finished printing, click the [Pause/Resume] button to restart video

display.
Setting Details
Print position Specifies the print position for the image.
Print camera Ticking this checkbox prints camera parameters such as the pan
information and tilt angles with the image.

Pjsplaying Information

Dialog boxes can be displayed that show the video, connection and camera information. To view
this information, select “Video Information”, “Connect Information”, “Camera Information” or
“Network” from the “View” menu.

Video Information

zl ® Frame rate
Frame rate: 2719 frames/sec Received frame rate
Size: E098  bytes/frame ® SiZe X
Captured image size: 320240 pizels Data CapaCIty per frame
@ Captured image size
Compression ype: Mation JPEG Height and width of the video data being

received
@ Compression type
Server’s video compression method
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Connection Information

xi| ®Protocol
WebView-TCP or WebView-HTTP
Protocal: Webigw-TCP ® Video [WV-TC p]
WiEf=m - S Vi, M, 1 sl IP address of camera server:port number
Camera contrallwy-TCP]: 192,168,100,1:65311 @® Camera control [WV_TCP]
videa/Cameral¥y-HTTP]: IP address of camera server:port number
Proxy: OFF @ Video/Camera [WV-HTTP]
Local time: 21 Sep 2004 09:26:39 GMT+09:00 IP address of camera server:port number
@ Proxy
Proxy usage information
@ Local time

Local time on the camera server (GMT)

Camera Information

Current camera pan angle
Camera angle .-gltrre i it |
: urrent camera tilt angle
Pan: 5,25 deg ® Zoom
Tilk: 168 deg Current camera zoom (viewing angle)
value
Zoarm: 41,26 deg @ BackLightMode
Current backlight adjustment ON/OFF
BackLightMade: OFF o f:t::ﬁ:r Model
CameraModel: Zaron YE-C50i Model of the camera
Network

x|| @Indicator (camera mark)

T Video data network band
@ Indicator (speaker mark)
g [ WESID 1355 Audio reception network band
~ * Not displayed if Audio is not connected.
f@ | 00 bops @ Restrict video data
- You can control the video data band traffic.
Trraffic L J High




Viewer for PC Settings

This chapter describes how to specify the software environment settings for
the Viewer for PC.




Viewer for PC Settings

From the “Setup Properties” window, you can specify a range of settings governing the operation of
the Viewer for PC. Normally, there is no need to alter these settings.

“Starting protocol” Setting

Specify whether connection to the camera server is to be made using the WebView-TCP
protocol or the WebView-HTTP protocol.

Procedure

III Select “Setup Properties” from the “View” menu.

IZI Select protocols from the “Options at starting with WVH file” in the “Starting protocol” tab.

Setup properties x|

@ “Auto select connection”
Use this setting when you do not know
the details of the connection
environment. When this option is
selected, the viewer first tries to connect
using WebView-TCP and then tries
WebView-HTTP.

Starting protacol |HTTP protocol | Display option |

—Options at starting with WyH File

video connection settings

£ WY-TCP protocol connection

" WA-HTTP protocol connection

Audio connection settings

¥ Receive audio data

® “WV-TCP protocol connection”
This setting uses the WebView-TCP
protocol used specifically by WebView
for TCP connections. To penetrate
el | firewalls with this protocol, a dedicated

application gateway is required.

® “WV-HTTP protocol connection”
This setting uses the WebView-HTTP protocol, which is the WebView protocol that conforms
to the ordinary HTTP standard. The HTTP proxy can be used as is and the firewall can be
passed.

@ “Receive audio data”
Remove the tick if you do not want to receive audio data.

E Viewing video from behind a firewall

To view video from behind a firewall using the WebView-HTTP protocol, you
must specify the HTTP proxy settings. You can set the same settings as the
HTTP proxy specified in your Web browser. If you want to access video from
behind a firewall, select WV-HTTP protocol. (See P.45 for details.)

Note



“HTTP protocol” Setting

Specify these settings when you are connecting using the WebView-HTTP protocol.

Procedure

III Select “Setup Properties” from the “View” menu and then select the “HTTP protocol”
tal

b.
IZI Setup properties x|l Enter each item. To automatically
Starting prctocol HITR protacel | biplay opkion | import Internet Explorer HTTP proxy
Proxy server settings tt | k uA H |E
settings, clic cquire proxy
¥ Use automatic configuration script Settlngs ’
Address:
[V Use Wy-HTTF proxy
Hast: Part:

Wh-HTTP proxy server: I 80

¥ Do not use the proxy For local hosts

Set hosts pot using proxy. (e.g. *.mygroup.com,172,20,28.%)

oK Cancel |

H Use automatic configuration script

Tick if you want to use the automatic configuration script. Once ticked, enter the URL
of the Settings file in the “Address” field.

B Use WV-HTTP proxy

.@:
Tip

[WV-HTTP proxy server]

Tick if you want to use an HTTP that uses a proxy. This then allows you to penetrate
firewalls. Once ticked, enter the domain name or IP address of the HTTP proxy
server host in the “Host” field, and enter the port number in the “Port” field.

[Do not use the proxy for local hosts]

Tick if you want to connect to local addresses without using the proxy.

[Set hosts not using proxy]

You can set up servers that can be accessed without using a proxy, not to use a
proxy. In this field, enter the domain name or IP address of the host that does not
use a proxy. To specify multiple hosts, use a comma (,) to separate the
specifications.

You can use asterisks (*) as wildcards in the host name in the “Set hosts not
using proxy.” setting. This allows you to specify multiple host names at once.
(Example)

192.168.100.*

Hosts with an IP address that begins with “192.168.100.” do not use the proxy.
*.webview.co.jp

Hosts on the network with the “webview.co.jp” domain name do not use the
proxy.




Viewer for PC Settings

“Display option” Setting

Use this setting to specify the size of the video displayed at startup. Note that the opening
screen shown at startup is displayed at an image size of 320 x 240.

Procedure

|I| Select “Setup Properties” from the “View” menu and then select “Display option”.

|Z| Select “Set video display size used at startup”.

Setup properties x|

Starting protocol | HTTP protacol - Display option |

Set video display size used at startup

" Adiust b default image size;
€~ Use a display size in list below

Middle: 'I

¥ Confirm when changing to Full screen made.

@ “Adjust to default image size”
When you connect to the server, the viewer starts up with the image size matched
to the image size initially sent.

@ “Use a display size in list below”
Allows you to select any of 4 sizes: Large, Middle, Small and Minimum.

" Adiust b default image size

% Use a display size in list below

IV Confir

Y The image size varies according to the type and settings of the connected

9
= camera server.
Tip
NTSC PAL

Large 640 x 480 768 x 576
Middle 320 x 240 384 x 288
Small 160 x 120 192 x 144
Minimum | 80 x 60 96 x 72




Registering and Changing the Server

The camera server can be registered beforehand and thereafter you can access the server simply by
selecting it from the registered servers. The procedures for registering and changing camera server
are described below.

E}gistering in a Camera Site List

Adding to a list

The camera server can be registered during connection by clicking the “Register connected
site” button or choosing “Register Site” in the File menu. If the site is currently not
connected, it can be registered following the procedure below:

Procedure
III Comera site st - X Choose “Camera Site List” from the
Bndnde o View” menu. When the camera site list
Do Kond Rivr — appears, click Add.
Up to 100 camera sites can be registered. B
add. | Dekz | Edi | S
(]
aK I Cancel | g
€L
—_
e
IZI Setup camera site{New) =] The “Setup camera site” dialog box T
Nekname: | appears. Enter each item and click “OK” (@)
to add a camera server to the list. w
Host Mame: I 'C_D._
=
—Wideo conneckion settings (8
= aukall) COWY-TCR(Z)  © WYSHTTR(E) wn
Yideo: |6531D—
Cameta Control: Ir
HTTP: IgU
—Audio connection settings
™ Receive audio data
HITR: ISU
B Nickname

Any name can be given to the camera server being registered.

B Host Name
Specify the IP address of the camera server.




H Video connection settings
[Auto] [WV-TCP] [WV-HTTP]
Select whether to connect to the camera server using auto selection, or to connect
using the WebView-TCP or WebView-HTTP protocol. When connecting with auto
selection, the viewer automatically selects the optimum protocol and connects to the
camera server. If you are connecting to the camera server from inside a firewall,
select WebView-HTTP (— pp.44, 45).
[Video] [Camera Control] [HTTP]
Specify the port numbers of the camera server. These are the values specified on
the camera server. They can normally be used with the default settings.

H Receive audio data
Remove the tick if you do not want to receive audio data.

Changing or deleting registration details in the list

Procedure
III Camera=ilEls E Choose “Camera Site List” from the “View”
T R T menu, and select the registered camera site

Harajuku Station

Ochanomizu Kanda River Down that yOU Want tO Change or delete
If you want to make changes in the details,
click Edit. To delete a site, click Delete.

aod. | Delte | EE|
Ok I Cancel |
E Setup camera site(Edit) 1 . Make the changes. Click “OK” to activate the
Micknare: I Shonan Zaimakuza Beach Changes .
Hosk Mame: I 202.228.129.21

~Wideo connection settings

7 Aukof1) i

i O WY-HTTP(Z)

Yidea: I B5324
Cameta Control: I 65325
HTTR: | a0

—Audio connection setbings

™ Recsive audio data

HITE: I 0




Registering and Changing the Server

IEI Comera site st g While a camera site is selected, you can
s Bron e move it to a different position in the list by
T = clicking the Up or Down button. This order is

reflected in the list displayed in the Site
Selection dialog box.




Appendix

Messages displayed in the viewers are explained in this section.




Error Messages

Viewer for Java Error Messages

Situation At connection

Message | too many clients

Details The limit on the number of video server connections has been exceeded.

Solution Access to the camera server is apparently overcrowded.
Wait some time and then reconnect.

Situation At connection

Message | can’t connect
version mismatched

Details The camera server is a different version.

Solution Clear the Web browser cache.

Situation At connection

Message | can’t connect

Details The viewer cannot connect to the camera server.

Solution There is a coding error in the Web page used for video distribution,
or there is a problem on the camera server. Check with the administrator of the video
distribution Web page.

Situation During camera control privileges acquisition

Message | couldn’t get camera control

Details The limit on the number of people queuing for camera control privileges has been
exceeded.

Solution Access to the camera server is apparently overcrowded. Wait some time and then
try again to acquire control privileges.

Situation At connection

Message | camera control is disabled

Details The viewer cannot connect to the camera control server.

Solution This is normal operation because camera control is prohibited by the camera server.




Situation At connection
Message | camera is off-line or abnormal
Details The connected camera is switched off or the RS cable is not connected.
Solution There is a problem with the camera server (with the camera power supply or the
RS cable connection). Check with the administrator of the camera server.
Situation | At disconnection
Message | disconnected
Details The connection time limit has expired or the connection was cut due to restart
processing on the camera server.
Solution To reconnect, reload (refresh) the Web page in your Web browser.

Viewer for PC Error Messages

Situation At connection
Message | No response from video server.
Details The viewer could not connect to the video server.
Solution There is a coding error in the Web page used for video distribution, or there is a
problem on the camera server. Check with the administrator of the camera server.
Situation | At connection
Message | Network is busy. Please try again later.
Details The limit on the number of video server connections has been exceeded.
Solution Access to the camera server is apparently overcrowded. Wait some time and then
try again to acquire control privileges.
Situation At connection
Message | No response from camera control server. You can use video only.
Details The viewer could not connect to the camera control server.
Solution This is normal operation because camera control is prohibited by the camera server.




Error Messages

Situation At connection

Message | Couldn’t get camera control privileges.

Details The limit on the number of people queuing for camera control privileges has been
exceeded.

Solution Access to the camera server is apparently overcrowded.
Wait some time and then reconnect.

Situation At connection

Message | You do not have video server access privileges.

Details There is a restriction applied in the camera server settings that limits the IP
addresses of clients allowed to connect.

Solution This is normal operation. This situation is set up by the camera server administrator.

Situation At connection

Message | Camera switched off or faulty.

Details The connected camera is switched off or the RS cable is not connected.

Solution There is a problem with the camera server (with the camera power supply or RS
cable connection).

Situation At connection

Message Invalid WVH file.

Details There was an error in the information in the WVH file.

There is a coding error (WVH file) in the Web page used for video distribution, or there
is a problem on the camera server. Check with the administrator of the web page.

Solution

Situation At disconnection

Message | Disconnected

Details The connection time has expired or the connection was cut due to restart processing on
the camera server.

Solution Restart your Viewer for PC.

Situation At connection

Message | Audio connection not possible

Details Audio connection not authorized on the server side, or the device does not have an
audio connection function.

Solution Check with the camera server administrator.
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